Cisco Jabber
User Training




Cisco Jabber Training

By the end of this session you will be able to:

JUse Cisco Jabber Effectively

JManage your Contacts and Groups
JUnderstand Presence and Change Your Status
JPlace and Receive Calls from Jabber
IConference and Transfer Calls

JUsing the Dock

JKnow Where to go for Help



Opening and Logging In
M

1. Launch the shortcut on your desktop. . ...

2. Use UPN format of your username in this form:
(domain will change to the
current domain you are such as ads, bds, and cds) ex.
craiga@bds.state.mo.us

3. Enter the password for logging into your computer. Check the
box that says “Login Automatically”

4. Click Log In

5. Once logged in, select File, Options, and check the box to
Automatically start Cisco Jabber when my computer starts.

6. When you next start your computer Cisco Jabber should start
automatically.


mailto:username@domain.state.mo.us

General Functions
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The main feature is that of Presence. It allows users to add contacts
and see when a person is available, in a meeting, away, on a call, or
has set a custom status such as out to lunch.

You can search the state phone directory maintained in Outlook.

Hovering over a user’s name makes a phone appear and gives the
user the ability to “click to call”’. When the phone is clicked the
target user’s phone rings and your phone is placed on speaker
phone. When call forwarding is active this feature should not be
used.

Double clicking a users name opens up a chat window. The chat
feature allows users to quickly communicate similar with instant
messages. Chat messages are considered public record the same as
email.

Right clicking on a contact and clicking send email allows you to
email directly from a contact to the email address stored in their
profile.

In addition you can see call history both incoming and outgoing.
Missed calls are highlighted in red. All can be directly dialed from the
list.

Voicemails are listed out under another icon with caller name,
number, duration, date, and time.

Upcoming meeting details are also pulled from Outlook.

Jabber also integrates with Outlook to allow for presence and click
to call.

Chat Room is used to join or read discussions on the theme of the
room with other chat room members.



Appearance

# — 0O X
File
Options...
Communicate
View « Show contact pictures
Help « Show offline contacts

Sign out Video call always on top
Exit « Show docked window
Position docked window
Show call statistics
Sort contacts by
« Show lakbel

« Show accessible presence icons

Refresh meetings list

Want your Jabber to
look like mine in the last
slide?

Go to the gear wheel,
then hover over “View”

Select “Show Label” to
see the names of the
categories on the left
side.

Select “Show Accessible
Presence Icons’ to see
presence icons with
small checks or dashes
in them.



Adding Contacts

You can search for people and add them to your contact list so that you can easily call or
instantly message them.

* In the Search box, enter the name of the person you wish to add and press Enter.
* Matching names and numbers are listed as search results.
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Offline

D Search chat room messages

Chats ol
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Add the contact(s) you want by selecting the cog icon # then File, New, and contact or
custom contact and enter the information for the contact.

® — 0O X |
File > Mew 3 Contact
Options... Import contacts... Customn contact
Communicate ¥ View my profile Group
View ¥ Change password... Chat room
Help ) Custom Tab
Sign out

Exit




Adding Custom Contacts

You can now add personal contacts that are not searchable in Jabber.

* To add a custom contact, go to the cog icon, choose File, New, and then Custom

contact. g — 0O X
File > Mew p] Contact
Options... Import contacts... Custom contact
Communicate > View my profile Group
View » Change password... Chat room
Help ¥ Custom Tab
Sign out
Exit

* Fill out the necessary information to create the contact. Name and telephone
number is required. Add as much information as you would like. Include the users

email if you would like to use right clicking the contact for initiating an email from
jabber, &) Create Custom Contact w0

Display name:
First name:

(=] Last name:
Chat {IM address):
Email:

Work phone -~



Creating a Group

To create a group in Jabber:

Step 1. From the menu cog select File, then New, then select

Group
# — 0O X

File ¥ Mew ¥ Contact
Cptions... Import contacts... Custom contact
Communicate » View my profile Group
View > Change password... Chat room
Help ¥ Custom Tab
Sign out
Exit

Step 2. Enter a name in the Group name text box and select Create

&) Create a New Group X

Group name: | Jabber Demonstration




Add a Contact to a Group

You can add anyone listed in the State of
Missouri Directory to a Jabber group.

Step 1. Create your group.

@ |

Step 2. Add your contact in one of the a
two ways previously mentioned.

Add to: Team ¥
Step 3. Change the group to the (® New group
desired group you wish to use or select
New Group and enter the name of your
new group. «<» -

Step 4. Click Add.

Alternatively, you can right click on an already added contact and
select Move to group and select the desired group.



Emailing from Jabber

You now have the ability to email directly from a contact listed in jabber to the email
stored in their profile.

* Right click on a contact and click on send email to initiate an email through
OutIOOk. £ Cisco Jabber m

— O =
. = Availlzbls
Lo} -
‘ ~  Teamn
- @
Aoway
% Alert when available
Calls . Chat
- Swanable call >
(=] call with edit s

Mestings . Available Start meeting

Schedule meeting
» Test send email

Edit profile...

i 8]

[}

> UC Metwork
View profile

hMowve to group *
Copy to group >

Remowve

1=~ % Connect to a device




Presence
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A user can set their presence
by selecting the arrow next to
their name, or it can be
automatically set by their PC.

Color coding allows users to
know availability at a glace.

A user who does not show a
colored status is not currently
sighed into Cisco Jabber

Presence messages can be
customized by selecting the
text below the name and
typing the customized
presence notification. The
customized notification is
viewable by all who can see
the users presence.



Availability

Availability status is the key to being productive. By knowing the real-time status of other state employees, you can
decide the best method of contact or response, and reduce communication delays. Jabber can determine
availability automatically, or people can specify their availability status manually. You can always try to contact
people regardless of their status.

Scan the contact list to see if a contact is away from their desk, on the phone, or in a meeting.

Availability Status is displayed in more than the contact list. It appears in the missed calls, visual voicemails and

IM chats.

Available The person: You can:
* Is logged in to Jabher = Call
» Has set their status to Available * Instant Message
* Has recently been using their computer | * Email
or phone
On the Phone # The phone is off the hook You can:
# The PC has been idle for more than 10 |« Call
Idle minutes * Instant Meszage
* The person is in @a meeting accordingto |« Email
In a Meeting Outlook calendar.
Do Mot # The person has set the statusin You can:
Disturb (DND) * Jabber to Do Not Disturh + Call
* Em ail
. * IM notification and voice mail will be
saved in the conversation window. You
are NOT notified of calls or messages.
The phone will still ring.
Offline The person: You can:
* |s not logeed into Jabber « Call
* Has zet their status to Out of the Office |« Email
Out of the Office from Jabber status preferences * Send IM (messages sent while offline
= Has hlocked you from seeing their will appear in the missed event counter
availability status. and will appear in their conversation

histo ry)




Start a person to person Chat

You can start a chat with anyone using Jabber by double-clicking their name.

If a contact is showing as offline you can still send a chat. It will be included in their missed event
counter along with the missed calls and voice messages.

Step 1. Double-click the name
in your contact list.

Step 2. Type the message.

x

Step 3 (Optional) Edit the font, | & - B
add participants, add an g5 a Y ¢ @
emoticon, send a file, send a _

screen capture, or add "

mention.

Step 4. Press Enter.




Chat Rooms

Use Chat Rooms to join or read
discussions on the theme of the room
with other chat members. For example,
you can create a themed chat room for
foreign exchange rates, where others
can join the room to discuss foreign
currency exchange rates.

Rk Chat rooms are available for Sunshine

requests and should be business
oriented only.

You can browse all rooms by viewing a
list of room names, join open rooms, or
be added to a room by another person
who created a chat room of their own.

You can be a member of multiple chat
rooms

You can filter room content by
keywords or senders

Rooms will be deleted after 7 days of
inactivity.

&) Cisco Jabber
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Filters
UC Support Group
o UC Systems Group
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All rooms
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Setting up a chat

Click the Chat Room icon in the main Jabber window,
and select the ‘All rooms’ tab

At the bottom of the page, select ‘New room’

Name: Choose a name for your room that will make
people want to join.

Description: Describe what the room is to be used
for.

Type: If you want this Chat Room to be private,
select ‘Restricted’. This will require the creator of the
chat room to give permission before a person can
join the chat room.

Location: Leave as ‘Automatically Select’. Put a
check mark next to ‘Add to My rooms’.

Moderators: If you want another person or persons
to be able to manage the room for you, enter their
names in the moderator’s box. You can enter up to
30 people as moderators.

Password: Clicking on the Password button will take
you to another screen where you can enter a
password. If you select this option, members will have
to enter the password every time they enter the
room. Enter the password information, then click
‘Save’.

8 My rooms Filters
il () Refresh st
»
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Rooms
Meetings
@ Mew Room
Room information
Name Jabber Demonstration

Description This is an example chat room.

Type
Public [Anyone can find and join the room)
o Restricted [Users must request access to the room)

Cannot be changed after room creation

Location Automatically select v

B Add to "My rooms”

Moderators
a |
{up to 30)
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Password Cancel
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Setting up a chat

If you chose to add your members now,
just type the name in the Search bar and
click on their name when it appears. Once
all the members have been added, click
‘Save’.

* If you chose to add your members later,
you will be brought back to the Chat
Room main screen. You will notice that the
room you created is not listed. Click on
the ‘Refresh list’

e To add members later, click on Chat
Rooms > My Rooms, then double-click on
the name of the room you want to add
members to.

* Click on the Room Information icon to
enter the names of the individuals you
want to be part of your Chat Room.

e Chat rooms have more possibilities and
further information is available on the PR
intranet site or by following this link

room

&) Cisco Jabber %

Jabber Demonstration room was successfully created

Would you like to add members to the room now?

Add later Add now

B a B
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https://extranet16.mo.gov/gettinghelp/Training/JabberWebex/Jabber%20Chat%20Rooms.aspx

Chat Room Settings

@ Jabber Demaonstration Edit room

Room information

Mame abber Demonstration

Description This is an example chat room.

Location conference-3-groupchat.state.mo.us

Type @ Restricted

Copy room link Mute this room

Administrator

Moderator(s) Q

Members

Room participant limit [max 999):

Password Delete room Cancel

999

These are the
various settings you
can adjust when
clicking the Room
Information icon
from the last slide.



Sharing your screen

* Select the three dots in the upper-
right corner of chat screen, then
share screen to share your screen @
with your chat partner.

[~

* If you choose to share and have @ @ o
more than one monitor you will
be asked which monitor you
would like to share. The person
you are chatting with will get an . H_—i

invitation to see your screen.

) Share Screen (Beta) — x

DELL P2217H DELL E2216H

* When you are finished sharing
select the red stop button at the _—
top of your screen




Quick meeting

% Connect to a device
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e |n the chat window,
select the three dots,
then Meet Now.

e The person you are
chatting with will be
asked to accept your
meeting invitation
and you will begin a
WebEx meeting.



Making a Call

Call a Contact in Your List

* Hover over the contact, the phone
appears, simply click the phone

* Right-click the contact and select Call

* |[f the contact has more than one
number listed in the corporate directory,
a drop down box will appear by the
phone to select work, mobile, etc.

Call a Contact from State Directory

* Enter the last name, first name in
the search field

* A list of names appears matching
your full or partial entries

* Hover over the contact, the phone
appears, simply click the phone

@ @ [E2 Meeting % Cacti Monitori
b (|- . ')d e [ B ET Team Email
eply Reply Forwar
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Jabber also integrates with Outlook and gives
you the ability to IM and Call from an email.



Receiving Calls

If Cisco Jabber is running when someone calls you, a notification window
displays on your computer screen.

) Incoming call X

o

Click one of the following options:

» Answer — Selecting answer automatically connects the call and
activates speaker phone.

* Decline — Selecting decline stops the phone from ringing and the call
eventually goes to voicemail.

* Chat reply-stops the phone from ringing and the call goes to VM but
open the IM feature to allow you to send the caller a chat message.

Any call that you do not answer will go to voicemail.

If you are already on a call when you answer a new call, the existing call will
automatically be put on hold.



The Active Conversation Window

An active conversation window displays on your PC which shows the
caller’s name, number, the time connected; and offers you control buttons
to manage your call.

AT e A e T
v Connect to a device

from your webcam.

Start sharing the video feed

Mute yourself
so you can’t be
heard on the call.

T @ @

l

000

|

Merge two or more
calls into one.

Put the call on hold
and retrieve it.

/7

Hold

N

Merge

Conference

—

End the call

Open the dial pad.

Share your screen with
the person you’re speaking with.

Transfer call to a
different number.
,

Transfer

Add another line
into the call.




) Conversa fions
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Conferencing a Call* ]

1. Select the “Conference” option
shown in the last slide under the
three dots.

2. If the person you're wanting to add
to the call is a state employee,
simply search for them in the
“Invite Participants” box. If they 00
are not a state employee, type in e —
the person’s full number in the 1@ s ot 1@ -
box. &

3. Then click the green connected :
button to merge the calls together.
After all parties are on the
conference they will show “In ’
conference”.

Note: Up to 8 callers can be in conference.




Transferring a Call

Step 1. Select the three dots in the Active
Conversation window.

Step 2. Select “Transfer”

Step 3. Type the name of the contact in the
state directory. If the person you want
to transfer to is not a state employee,
simply enter in a phone number.

Step 4. Click the phone button next to the
name of the user with whom you want
to transfer to.

Step 5. After you speak to the caller you are
transferring to, click the “Transfer”
button. You will be immediately
disconnected from the call.
Alternatively, you can click the green
“Transfer” button right away to
transfer them immediately without
speaking to the destination first.

Note: If you cannot reach the transfer recipient you
can hang up the call to them and click the pause button
to resume talking to the original caller.

@ WIRELESS CALLER

WIRELESS CALLER

Hold

Merge Transfer

Conference

- 0O X
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@ WIRELESS CALLER

WIRELESS CALLER

WIRELESS CALLER
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Click or  — ®
hover over this to

USing the DOCk show the dock.

L@Q + © =

e The dock allows the search
box, missed calls, voicemail,

Alert when available

Add contact
and Jabber application to be Chat
quickly accessed. o :

Start meeting

Schedule meeting

e You can search and right Send ermail

View profile

click a contact to chat, call,
or start an instant meeting.
You can also simply click the = — 5 x,

phone by the user’s name. Fle A
Options.., 3 AN
Communicate » A ﬂ_ ;
View » | +~ Show contact pictures
The dOCI( Can be turned On :erF:Dut el ZT;;::E;E::H;;;T:ZT\StDp
and off by selecting View, Exit e
Position docked window ¥

Show docked window.

Show call statistics
e @ Sort contacts by >
« Show label

« Show accessible presence icons

Refresh meetings list



Where to Get Support

Three Main Resources:

e For immediate assistance, call 573-522-0082

e For changes & trouble tickets, use the Help Desk

e For tutorials & more information use the VWeb Portal


https://itsdserviceportal.state.mo.us/CherwellPortal/IT?_=20791cb0
http://oa.mo.gov/itsd/uc/
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